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[1] About MolWorks 
MolWorks is a software tool for computer aided molecular design. 
●Multi-platform support 

MolWorks can be run on any platform running a JavaTM VM (Virtual machine), such as 
Windows and Linux (Redhat).  
●About modeling 

MolWorks can build molecules by drawing them within the Builder Panel. MolWorks can handle 
3D molecules. You can clean up molecules by using a simple minimization algorithm. You can 
easily change atom type and bond order for molecule. You can select Wire/Ball & Stick style. You 
can handle many molecules by using tab panels. 
●Reading molecule files and output files of computational chemistry programs, and saved 

molecule files 
MolWorks can read molecule files (XYZ Format File(*.xyz) & Protein Data Bank File(*.pdb) in 
Version 2.0) and display molecules within the Builder Panel. In addition, it can read input 
output files of Gaussian, GAMESS, MOPAC, and Q-Chem, and can analyze and visualize the 
results. MolWorks also can write molecule files (only XYZ Format File(*.xyz) in Version 2.0) and 
input files for the programs (see next). 
●Pre and Post processors for quantum mechanics programs 

MolWorks has interfaces for Q-Chem / Gaussian / GAMESS / MOPAC. MolWorks include a 
CNDO/2 calculation engine and can display the MO (Molecular Orbital) within the Builder 
Panel. 
MolWorks can convert a Gaussian input data into a Q-Chem input data and create an input 
data file for Q-Chem. 
MolWorks can submit a Gaussian job. (only when Gaussian program is installed locally.) 
●Properties Estimation 

MolWorks can estimate molecular properties using “Group Contribution Methods” and 
“Principle of Corresponding States”. You can estimate molecular properties and squeeze down 
the target molecule from the list. MolWorks can display diagram of “Equation of the State” for 
the molecular mixtures. 

[2] System Requirements 
Windows 98/2000/NT 4.0/XP (Pentium MMX 233MHz and above) 
Linux (Redhat) 
 
45MB hard disk space (including JavaTM VM) 
32MB RAM (64MB recommended) 
256 color VGA monitor (800x600 or greater) 
Ethernet Card or Ethernet Board is necessary. 
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[3] How To Start Up 
●Windows Users 
Execute the MolWorks from the “Start Menu”. 
●Linux Users 
Execute the command MolWorks from the command line in the window. 
 
While the Startup Window is displayed, several modules are loaded. Then Initial Display will be 
appeared on the screen. 
 
（Startup Window）  （Initial Display） 
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[4] Display Contents 
The Initial Display consists of the Main Menu / Main Window / Status Bar. 
（Initial Display） 
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I. Main Menu 
1) File 

 
 
 
 
 
 

1)-a. New 
In the case of the Molecule Window and Periodic Table Window are opened in the Main 
Window. If the Molecule Window is already displayed, new Builder Panel will be 
added. 

 

1)-b. Open… 
The browser for open file will be appeared. Select a molecular coordinate file and press 

. The molecular structure will be displayed in the Builder Panel. 
1)-b-1: File name 

Display the selected file name. 
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1)-b-2: Files of type 
Specify the reading file type. In version 2.0, it can read XYZ Format 
File(*.xyz), Protein Data Bank File(*.pdb), and input and output files of 
Gaussian, GAMESS, MOPAC, and Q-Chem. When the input files are read, 
the molecular structure with the options and parameters for the calculation 
are displayed, and when the output files are read, the molecular structure 
with the results of calculation are displayed. 

 

1)-b-3: In the case of reading Gaussian input file (h2o.com) 
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1)-b-4: In the case of reading Gaussian output file (h2o.log) 

 

1)-b-5: In the case of reading GAMESS input file (h2o.inp) 
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1)-b-6: In the case of reading GAMESS output file 

 

1)-b-7: In the case of reading MOPAC input file (benz.dat) 

 

 7



1)-b-8: In the case of reading MOPAC output file (benz.out) 

 

1)-b-9: In the case of reading Q-Chem input file (water.in) 
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1)-b-10: In the case of reading Q-Chem output file (water.ref) 

 

1)-b-11: The orbital energy level 
The orbital energy level is displayed when the output files are read and the 

 button in the Information Window is pressed.  
1)-b-12: Frequency 

The spectrum of IR is displayed if the result of vibrational analysis is 
included in the output files and the  button in the Information Window 
is pressed. 
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1)-c. Rename… 
Rename the selected Builder Panel. 
Example: Change the name ‘Molecule 1’ to ‘Water’. 

 

Procedure 1) Select Rename Molecule 1 from the Edit menu in the Builder Panel. 

 

Procedure 2) Change the name ‘Molecule 1’ to ‘Water’ in the Rename Molecule display. 
After clicking , this panel is renamed. 
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1)-d. Close… 
Close the selected Builder Panel. 
Example: Close the ‘Water’ Builder Panel. 
Procedure 1) Select Close Water from the Edit menu in the Builder Panel. 

 

Procedure 2) Close Molecule dialog will be appeared.  for closing this file. 

  

1)-e. Save As… 
Save the molecular structure displaying in the Builder Panel. 
Example: Save the geometry of acetaldehyde as test.xyz file 
Procedure 1) Select Save As… from Edit menu in the Builder Panel. 

 

Procedure 2) The browser for Save file will be appeared. After changing the file name 
‘acetaldehyde.xyz’ to ‘test.xyz’, press . 

 

Procedure 3) If the same file name already exists there, following message dialog will 
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be displayed.   

 

1)-f. Exit 
Display the Exit dialog. 

 

2) View 

 

2)-a. Molecule 
Display the Molecule Window. When the Molecule Window is already displayed, it 
comes to the front of the display. 

2)-b. Periodic Table 
Display the Periodic Table Window. When the Periodic Table Window is already 
displayed, it comes to the front of the display. 

2)-c. Messages 
Display the Messages Window. When the Messages Window is already displayed, it 
comes to the front of the display. 

3) MO 
 

3)-a. Interface 
Display the Simplified Setting Window for creating input files for Q-Chem, Gaussian, 
GAMESS and MOPAC. 

3)-b. Calc 
Display the CNDO/2 Window for CNDO/2 calculation. 

4) Properties 
 

4)-a. Estimation 
Display the Estimation Window. 

5) Window 

 

5)-a. Already existed window(s) 
Checked window brings to the front of the display. 
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6) Help 
 

6)-a. System Information 
MolWorks displays the System Information dialog box. 

6)-b. About MolWorks 
The About MolWorks dialog box is displayed. 
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II. Main Window 
For the following windows: Molecule Window, Periodic Table Window, Simplified Setting 
Window, MO Window, MO Setup Window, CNDO/2 Window, Estimation Window, Pure 
Properties Window, Properties Graph Window, Functional Groups Window, PVT Window and 
Messages Window are displayed with in Main Window. 
To minimize the window, click the  button. The minimized window will be displayed at the 
bottom of the Main Window. 
While the  button is shown, you can change the size of the window. To maximize the 
window, click the  button. To close the window, click the  button. 

III. Status Bar 
Choose the Status Bar from the View menu. The following status bar is displayed at the 
bottom of the Main Window: 

 
            ①              ②     ③    ④ 
① Messages are displayed here. 
② The element type and the serial number of the atom are displayed here (e.g. C(1)). 
③ Display the number of total atoms in the Builder Panel (e.g. Atom count: 8). 
④ Mode is displayed here (Draw or Select). 
 

[5] Molecule Window 
The Molecule Window consists of the Menu Bar, Tool Bar, and Builder Panel. In the Builder Panel, 
you can operate several molecules using tab panels. In the bottom of the window, the methods to 
manipulate for the displayed molecule using button and mouse are displayed. 

 

 
 
 
 

 14



I. Menu Bar 
1) Edit 

 

1)-a. Undo 
Undo the previous editings. 

1)-b. Redo 
Redo the editings. 

1)-c. Cut 
Cut the selected atom(s). 

1)-d. Copy 
Not supported in Version 2.0. 

1)-e. Paste 
Not supported in Version 2.0. 

1)-f. Delete 
Delete the selected atom(s). 

1)-g. Select 

 

1)-g-1: All 
All atoms in the selected Builder Panel will be selected. 

1)-g-2: Atom 
The clicked atom(s) will be selected/unselected. 

1)-g-3: Box 
The white line box will be shown from the clicked point. All atom(s) in the 
white line box will be selected/ unselected. 

1)-g-4: Element Type 
All atom(s) being a same element type with the clicked atom will be selected/ 
unselected. 

1)-g-5: Bond 
The clicked bond(s) will be selected/unselected. 
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1)-h. Atom Type 
Choose the element type for drawing. 

 

1)-i. UnSelect 
When the selected atom(s) and/or bond(s) are existed, this command becomes active. 
When you choose this, all selected atom(s) and/or bond(s) will be unselected.  

1)-j. Draw 
Set the draw mode. 

1)-k. Add Hydrogens 
Adding the hydrogen atoms automatically considering the bond orders, distances, angles 
and dihedral angles. 

1)-l. Clean 
Execute a simple geometry optimization. If the energy is under 0.5 a.u. or the number of 
calculation cycles achieve 300, calculation is finished. If you open the new Builder Panel 
or select other Builder Panel during the calculation, optimization is stopped. 

2) Measure 

 

2)-a. Distance 
Measure the distance between two selected atoms, and display the value in the Status 
Bar ①. 
Example: Measurement of the C=O distance in ‘acetaldehyde’ 
Procedure 1) Select Distance from the Measure menu. Then the following message 
appears in the Status Bar ①. 

 
Procedure 2) Select two atoms in the Builder Panel. The distance is displayed in the 
Status Bar ①. 

 

 
 
 

 16



2)-b. Angle 
Measure the angle between three selected atoms, and display the value in the Status 
Bar ①. 
Example: Measurement of the O-C-C angle in ‘acetaldehyde’ 
Procedure 1) Select Angle from the Measure menu. Then the following message 
appears in the Status Bar ①. 

 

Procedure 2) Select three atoms in the Builder Panel. The angle is displayed in the 
Status Bar ①. 

 

 

2)-c. Dihedral 
Measure the angle between four selected atoms, and display the value in the Status 
Bar ①. 
Example: Measurement of the O-C-C-O dihedral angle in ‘acetaldehyde’ 
Procedure 1) Select Dihedral from the Measure menu. Then the following message 
appears in the Status Bar ①. 

 
Procedure 2) Select four atoms in the Builder Panel. The dihedral angle is displayed in 
the Status Bar ①. 

 

 
3) Bond 

 

3)-a. Single・Double・Triple 
Change bond order of the selected bond to single, double, or triple. 
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4) Label 

 

4)-a. Element Symbols 
Display the element of each atom. 

 

4)-b. Serial Numbers 
Display the serial number of each atom. 

4)-c. Charge 
Display the partial atomic charge of each atom after the results have been obtained 
from the CNDO/2 calculation. 

※ Element Symbols, Serial Numbers, and Charge can be displayed simultaneously. 
5) Display 

 

5)-a. Wire 
Display the molecule as a wire frame style. 

5)-b. Ball & Stick 
Display the molecule as a ball and stick style. 

5)-c. MO 
Display the molecular orbital, if the CNDO/2 calculation has already finished. 

5)-d. Wire Frame Movement 
Translation, rotation, and zoom of the molecule will be performed using the wire frame 
style (although the molecule is displayed in ball & stick style). 

5)-e. Axis 
Display the XYZ axes on upper left corner of the Builder Panel. 

 

5)-f. Home position 
Change the molecular direction to the one of the axes above, and move the center of 
mass of the molecule to the center of the Builder Panel. 
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5)-g. Center 
Move the center of mass of the molecule to the center of the Builder Panel. 

II. Tool Bar 
 

 Cut button. This button becomes active when one or more atoms are selected on the 
Builder Panel. The selected atoms are deleted when this button is pressed. 

 Copy button. Not supported in Version 2.0. 
 Paste button. Not supported in Version 2.0. 
 Undo button. Undo the previous editings. 
 Redo button. Redo the editings. 

 Add Hydrogen button. Adding the hydrogen atoms automatically considering the 
bond orders, distances, angles and dihedral angles. 

 Clean button. Execute a simple geometry optimization. 

[6] Periodic Table Window 
In draw mode, element types can be selected by clicking the appropriate button. Also, clicking on 
the required element can change selected atoms in the Builder Panel. The background color of 
each element is adopted in the Builder Panel. 
Also atomic number, mass of element (IUPAC), melting point, boiling point, specific heat and 
density are displayed at the top of the window. 

 

 
 
 
 
 
 
 
 

 19



[7] Simplified Setting Window 
The Simplified Setting Window is the basic window to create the input files for Q-Chem, Gaussian, 

GAMESS and MOPAC. When you want to set any parameters, please click . Then the 

MO Window will be displayed. 
I. Selecting the Q-Chem button. 

 

1)  
Save the Q-Chem input file for geometry optimization by RHF/STO-3G. 
Example：H2O 
$comment 
H2O 
$end 
 
$rem 
JOBTYPE       SP 
EXCHANGE      HF 
BASIS         STO-3G 
$end 
 
$molecule 
0 1 
O  4.4300385  -1.6507636  -0.6619955 
H  3.4728384  -1.6507636  -0.6619955 
H  4.669702  -1.6507636  -1.5887065 
$end 

II. Selecting the Gaussian button 

 

1)  
Save the Gaussian input file for geometry optimization by RHF/STO-3G. 
Example：H2O 
#P  RHF/STO-3G  OPT 
 
- Comment line -   H2O 
 
0 1 
O  0.0  0.0  0.0 
H  0.96  0.0  0.0 
H  -0.282  0.918  0.0 

 20



III. Selecting the GAMESS button 

 

1)  
Save the GAMESS input file for geometry optimization by RHF/STO-3G. 
Example：H2O 
$CONTRL SCFTYP=RHF RUNTYP=OPTIMIZE COORD=CART ICHARG=0 MULT=1 $END 
$BASIS GBASIS=STO NGAUSS=3 $END 
$GUESS GUESS=HUCKEL $END 
$DATA 
- Comment line -   H2O 
Cn 1 
 
O  8  0.0  0.0  0.0 
H  1  0.96  0.0  0.0 
H  1  -0.282  0.918  0.0 
$END 

IV. Selecting the MOPAC button 

 

1)  
Save the MOPAC input file for geometry optimization by PM3. 
Example：H2O 
PM3 XYZ PRECISE 
- Comment line -   H2O 
- Comment line -    
O  0.0   1 0.0   1 0.0 1  
H  0.96   1 0.0   1 0.0 1  
H  -0.282   1 0.918   1 0.0 1  

V. Q-Chem・Gaussian・GAMESS・MOPAC 

After clicking , the MO Window is displayed. 
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[8] MO Window  
The MO Window consists of four tabs concerned the four programs (Q-Chem, Gaussian, GAMESS, 
and MOPAC). 
I. Q-Chem 

Make input data for Q-Chem.  

 

1) Calc. Type 
Select the calculation type. 
Single Point・Optimize・Frequencies・Transition Structure・Using data on right（other 
calculation type written in the text field is adopted） 

2) Calc. Level 
Select the calculation type. 
RHF：Restricted Hartree-Fock 
UHF：Unrestricted Hartree-Fock 
ROHF：Restricted open shell Hartree-Fock 
MP2：2nd order Moller-Plesset perturbation 
CCD：Coupled Cluster with Doubles 
CCSD：Coupled Cluster with Singles and Doubles 
QCISD：Quadratic Configuration Interaction 
OD：Optimized Orbital Coupled Cluster Doubles 
BLYP：Becke exchange + LYP correlation 
B3LYP：Becke’s Three Parameter Hybrid Method Using the LYP Correlation  
B3PW91：Becke’s Three Parameter Hybrid Method Using the PW91 Correlation 
EDF1：Empirical Density Functional 1 
Using data on right：(other calculation type written in the text field is adopted) 

3) Basis Set 
Select the basis set. 
STO-3G・3-21G・4-31G・6-31G・6-311G・Using data on right (other basis set written in 
the text field is adopted) 

4) Polarization/Diffuse 
Select the type of polarization and/or diffuse function. 
Not used (Not including both polarization and diffuse.)・*・**・+・++・* and +・** and +・
** and ++ 
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5) Geometry 
Specify the geometry type. 
Cartesian：Set up the selected molecular geometry using the XYZ format automatically. 
Modify：Geometry Frame is displayed. If Save button is pushed after changing structure 
data within the Geometry Frame, the changed structure save to the file. 

6) Charge 
Set the net charge of molecule. 

7) Spin 
Set the spin multiplicity of molecule. 

8)  
Display the Additional Keyword Frame. Input keywords, and push the Save button when 
you want to add other optional keywords. 

II. Gaussian 
Make input data for Gaussian. The function to convert input data (Input Data Convert 

section) and to submit a Gaussian job (Run Gaussian Job section) can be used. 

 

1) Output Level 
Control the volume of output file. 
#(normal)・terse・detail 

2) Calc. Type 
Select the calculation type. 
Single Point・Optimize・Freq・Optimize + Freq・Using data on right (other calculation type 
written in the text field is adopted) 

3) Calc. Level 
Select the calculation level. 
RHF : Restricted Hartree-Fock 
UHF : Unrestricted Hartree-Fock 
ROHF : Restricted open shell Hartree-Fock 
CCD : Coupled Cluster with Doubles 
CCSD : Coupled Cluster with Singles and Doubles 
QCISD : Quadratic Configuration Interaction 
MP2 : 2nd order Moller-Plesset perturbation 
BLYP : Becke exchange + LYP correlation 
B3LYP : Becke’s Three Parameter Hybrid Method Using the LYP Correlation  
Using data on right (other calculation level written in the text field is adopted) 
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4) Basis Set 
Select the basis set. 
STO-3G・3-21G・4-31G・6-31G・6-311G・Using data on right (other basis set written in 
the text field is adopted) 

5) Polarization/Diffuse 
Select the type of polarization and/or diffuse function. 
Not used (Not including both polarization and diffuse.)・*・**・+・++・* and +・** and +・
** and ++ 

6) Geometry 
Specify the geometry type. 
XYZ.auto：Set up the selected molecular geometry using the XYZ format automatically. 
Modify：Geometry Frame is displayed. If Save button is pushed after changing structure 
data within the Geometry Frame, the changed structure save to the file. 

7) Charge 
Set the net charge of molecule. 

8) Spin 
Set the spin multiplicity of molecule. 

9)  
Display the Additional Keyword Frame. Input keywords, and push the Save button when 
you want to add other optional keywords. 

10) Input Data Conversion 
Convert the input data for Gaussian into the input data for Q-Chem, and save the 

converted data to file as a Q-Chem format. If Save button in Input Data Conversion section 
is pushed after editing input data on the Gaussian tab, the conversion is carried out. 

11) Run Gaussian Job 
If Run button in Run Gaussian Job section is pushed, the Gaussian program is executed. 

At first, input data edited in the Gaussian tab is saved at a file, then the Gaussian job is 
submitted. (To use this function, the Gaussian need to be installed locally. And some setup is 
required at Setup Window. 

III. GAMESS 
Make input data for GAMESS (The General Atomic and Molecular Electronic Structure 
System). 

 

1) Calc. Type 
Select the calculation type. 
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Single Point・Gradient・Optimize・Frequencies・Using data on right (other calculation type 
written in the text field is adopted) 

2) Optimize Cycle 
Specify the maximum number of iteration for geometry optimization. This button becomes 
active only in the case that Optimize is selected in Calc. Type. 

3) Optimize Precision 
Specify the precision of geometry optimization. This button becomes active only in the case 
that Optimize is selected in Calc. Type. 

4) Calc. Level 
Select the calculation level. 
RHF : Restricted Hartree-Fock 
UHF : Unrestricted Hartree-Fock 
ROHF : Restricted open shell Hartree-Fock 
Using data on right (other calculation level written in the text field is adopted) 

5) Geometry 
Specify the geometry type. 
XYZ.auto：Set up the selected molecular geometry using the XYZ format automatically. 
Modify：Geometry Frame is displayed. If Save button is pushed after changing structure 
data within Geometry Frame, the changed structure save to the file. 

6) Basis Set 
Select the basis set. 
STO-3G・3-21G・4-31G・6-31G・6-311G・Using data on right (other basis set written in 
the text field is adopted) 

7) Polarization 
Select the type of polarization function. 
not used・p (for H-He)・d・f (for Li-Cl)・p,d・d,f・p,d,f 

8) Diffuse 
Select the type of diffuse function. 
not used・s(for hydrogen)・s,p(for heavy atoms)・s,p(for all atoms) 

9) Time Limit 
Set the maximum time of calculation (minute). 

10) Memory 
Set the maximum memory used for calculation. 

11) Charge 
Set the net charge of molecule. 

12) Spin 
Set the spin multiplicity of molecule. 

13)  
Display the Additional Keyword Frame. Input keywords, and click the Save button if you 
want to add other optional keywords. 

IV. MOPAC 
Make input data for MOPAC6 and MOPAC7. 
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1) Calc. Method 
PM3・AM1・MNDO・MINDO/3 

2) Calc. Type 
Optimize・Frequencies・Thermo Data・Keyword (other calculation type written in the text 
field in the Calc. Type Parameters is adopted) 

3) Geometry 
Specify the geometry type. 
XYZ.auto：Set up the selected molecular geometry using the XYZ format automatically. 
Modify：Geometry Frame is displayed. If Save button is pushed after changing structure 
data within the Geometry Frame, the changed structure save to the file. 

4) Calc. Type Parameters 
4)-a. Optimize Algorithm 

Select the algorithm for geometry optimization. This button becomes active only in the 
case that Optimize is selected in Calc. Type. 
EF (Eigenvector Following)・BFGS 

4)-b. Thermo Data 

 

4)-b-1: Initial Temp. 
Specify the initial temperature. This field becomes active only in the case 
that Thermo Data is selected in Calc. Type. 
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4)-b-2: Final Temp. 
Specify the final temperature. This field becomes active only in the case that 
Thermo Data is selected in Calc. Type. 

4)-b-3: Step Number 
Specify the step size of temperature. This field becomes active only in the 
case that Thermo Data is selected in Calc. Type. 

4)-b-4: Symmetric Number 
Specify the symmetric number of geometry. This field becomes active only in 
the case that Thermo Data is selected in Calc. Type. 

Point group
symmetry

Symmetric
Number

Point group
symmetry

Symmetric
Number

Point group
symmetry

Symmetric
Number

C1,Ci, Cs 1 D2, D2d, D2h 4 Cv 1
C2, C2v, C2h 2 D3, D3d, D3h, 6 Dh 2
C3, C3v, C3h 3 D4, D4d, D4h 8 T, Td 12
C4, C4v, C4h 4 D6, D6d, D6h 12 Oh 24
C6, C6v, C6h 6 S6 3

 

4)-c. Interatomic Distance Check 
Write the keyword GEO-OK (ON) or not (OFF). GEO-OK override the job termination, 
which is due to that two atoms are within 0.8 Å of each other. 

4)-d. Orbital output 
Specify which the enable or disable to display the information of molecular orbital. 

4)-e. Time Limit 
Set the maximum time length of calculation (by the selected unit). 

 

4)-f. Charge 
Set the net charge of molecule. 

4)-g. Spin 
Set the spin multiplicity of molecule. 

4)-h.  
Display the Additional Keyword Frame. Input keywords, and push the Save button 
when you want to add other optional keywords. 

[9] Setup Window 

 
1) Work Directory 

Set a default directory for saving a Gaussian input data file 
2) Application 

Set the executable file of Gaussian. (In the case of Gaussian98, it is set to g98 (Linux) or 
g98.exe (Windows) ) 
The above two items are set using the Search button. If OK button is pushed, the setup 
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becomes effective.  
 

3) Other setup 
In addition to a setup on the Setup Window, the following setup is necessary for submitting 
Gaussian jobs. (The method for setting up in the case of using Gaussian98 is shown as an 
example. Please refer to the Gaussian manual for details) 
 

3)-a. Linux 
Before starting the MolWorks, a setup of an environment variable, g98root, and execution of 
a script is required. In the following examples, it is assumed that the Gaussian is installed 
at /opt/g98. 
 
In the case of C shell 
setenv g98root /opt 
source $g98root/g98/bsd/g98.login 
 
In the case of BA shell 
export g98root=/opt 
source $g98root/g98/bsd/g98.profile 
 
If the above-mentioned procedures are described to .cshrc file (C shell) or .bashrc file (BA 
shell), the setup is available whenever the shell is started. This can be used when executing 
MolWorks from a command line. 
 
If the above-mentioned procedures are described to .login file (C shell) or .bash_profile file 
(BA shell), the setup is available whenever a user logs in. This can be used when executing 
MolWorks by the double click of a mouse. 
 
 

3)-b. Windows 
Before starting the MolWorks, it is necessary to add the directory where the Gaussian is 
installed (ex. C:¥G98W) to an environment variable, PATH. 
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[10] CNDO / 2 Window 
Execute the CNDO/2 calculation.(Maximum # of atoms: 100, Maximum # of orbitals: 300) 

 

I. Input Parameters 
1) SCF convergency 

This parameter decides the precision of SCF calculation (thresh hold of the difference of 
molecular orbital energies). Default value is set to 0.000001. 

2) Max Cycles 
This parameter decides the maximum number of iteration of SCF calculation. Default value 
is set to 100. 

3) Charge 
Set the net charge of molecule. 

4) Spin 
Set the spin multiplicity of molecule (only the singlet state is supported in version 2.0). 

II. Results 
1) Number of Cycle 

Display the actual iteration number of SCF calculation. 
2) Energy Difference (a.u.) 

Display the maximum value of the difference of molecular total energies in the iteration. 
3) Energy (a.u.) 

Display the total energy of the molecule. 
III. Dipole Results 

1) Dipole (debye) 
Display the absolute value of dipole moment. 

2) X (debye),Y (debye),Z (debye) 
Display the component of dipole moment along X, Y, and Z direction. 

IV.  
Execute the CNDO/2 calculation. 

V.  
Display the MO Control Window and the shape of highest occupied molecular orbital (HOMO) 
in the Builder Panel. This button becomes active only in the case that the CNDO/2 calculation 
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is converged. 
VI.  

Calculate and display the absolute value of dipole moment, and its component along X, Y, and 
Z-axes. This button becomes active only in the case that the CNDO/2 calculation is converged. 

[11] Display MO Window 
Control the displaying molecular orbital resulted by CNDO/2 calculation. 

 

I. Current Energy Level 
Display the energy of selected orbital (indicated by red arrow). 

II. Change Level 
Up or down the level of molecular orbital displayed within the Builder Panel. 

III. S Scale 
Multiply or reduce of S orbital component of molecular orbital displayed within the Builder 
Panel. 

IV. P Scale 
Multiply or reduce of P orbital component of molecular orbital displayed within the Builder 
Panel. 

V. Show MO 
Set the molecular orbital displayed within the Builder Panel to HOMO1) or LUMO2). 
Example: The LUMO of ethylene. 
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1) Highest Occupied Molecular Orbital. 2) Lowest Unoccupied Molecular Orbital. 
VI. MO Level 

All of the molecular orbitals are displayed. The red arrow points the level of selected orbital. If 
the orbital set that the difference of orbital energies is below 0.0001 hartree is existed (i.e., 
degenerated orbitals are existed), it displays as right-hand below. 

 -  
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[12] Estimation Window 
I. Pure Properties 

 

1) Molecule 
All molecules displayed in the Molecule Window are listed in the pull down menu. When 
certain molecule is selected in the pull down menu, this molecule is displayed in the 
Builder Panel automatically. And when certain molecule is selected in the Builder Panel, 
this molecule is displayed in this menu automatically. 

2) Parameter 
Select the parameter for estimation. 

2)-a. Joback 
Joback, K. G., “S.M. thesis in chemical engineering”, Massachusetts Institute of 
Technology, Cambridge, Massachusetts, 1984. 

2)-b. Modified Joback 
Use Joback parameters determined by us with some modification. 

3)  
Estimate the pure properties of molecule using selected parameter. And display the Pure 
Properties Window and the Functional Groups Window (the groups and the number of 
each groups using in the calculation are displayed within this window). 
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4) Graph 
Select the property for plotting the graph. Only the vapor pressure is supported in version 
2.0. 

4)-a.  
Display the graph of selected properties vs. temperature. 

   

II. PVT 
Draw the PVT (Pressure – Volume – Temperature) graph. 

       

1) First Molecule 
Specify the first molecule and condition. 

1)-a. Molecule 
Select molecule in the Builder Panel. 

1)-b. Mol Ratio 
Set the ratio of mixture. 

1)-c. Exp. Boiling P. 
Set the experimental boiling point if you already know. If you set it, the estimation is 
more accurate. If you don’t set this, estimated boiling point from Joback parameter is 
used. 

2) Second Molecule 
Specify the second molecule and condition. 
The descriptions of the settings for second molecule are same as above. 

3)  
Estimate properties and draw PVT graph using condition in First and Second Molecule. 
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[13] Functional Groups Window 
This window displays the groups and the number of each group used for properties estimation. 

 

[14] Messages Window 
Display the messages of MolWorks. 

 

[15] How to use mouse 

 

I. Rotation 
When you move a cursor to right or left on the Builder Panel with holding on the control 
button, the molecule will be rotated by Y-axis. When you move a cursor to up or down on the 
Builder Panel holding on the control button, the molecule rotate by X-axis. 

II. Rotation (Z axis: perpendicular to the window) 
When you move a cursor to right or left on the Builder Panel with holding on the control 
button and the shift button, the molecule rotates on Z-axis. 

III. Magnification and Reduction 
When you move a cursor to the right on the Builder Panel holding on the shift button, the 
molecule is magnified. When you move a cursor to left on the Builder Panel holding on the 
shift button, the molecule is reduced. 

[16] About dealing molecule(s) 
I. Max atoms  

1000 atoms 
II. Move atom(s) 

1) Moving all atoms 
You should click the left button of mouse and drag the pointer to the place where you 
want. 
 

2) Moving the selected atom 
You should click the right button of mouse and drag the pointer to the place you want. 
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III. Building the molecule 
Example: building ethanol 
Procedure 1) If you select New from File of the menu bar, new molecule panel is shown. When 
you click on the Builder Panel, one carbon atom is displayed (Carbon is the default atom). 
Procedure 2) When you move mouse pointer, the white line is drawn from the first carbon. 

   

Procedure 3) If you click the point you want to place the second carbon, C-C bond is drawn. 
Procedure 4) If you want to change the selected atom from carbon to oxygen, you should click 
O on the Periodic Table Window or selecting Edit -> Atom Type -> Oxygen from menu bar of 
the Molecule Window. 
Procedure 5) When you click the second carbon and move a pointer, the white line appears 
from the second carbon. When you click the point you want to place the oxygen, the C-C-O is 
drawn. 

   

Procedure 6) Hydrogen(s) are added by clicking  from the Tool Bar or selecting 
Edit -> Add Hydrogens from menu bar of the Molecule Window. 
Procedure 7) The molecule cleaned up by clicking  from the Tool Bar or selecting Edit -> 
Clean from menu bar of Molecule Window. 
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[17] Supported file format 
I. Import 

XYZ Format Files(*.xyz) 
Protein Data Bank File(*.pdb) 
Q-Chem Input File(*.in, *.inp) 
Q-Chem Output File(*.out, *.log, *.ref) 
Gaussian Input File(*.com, *.inp) 
Gaussian Output File(*.out, *.log) 
GAMESS Input File(*.com, *.inp) 
GAMESS Output File(*.out, *.log) 
MOPAC Input File(*.dat) 
MOPAC Output File(*.out) 

II. Export 
XYZ Format Files(*.xyz) 

III. XYZ type 
# Comment (First line) 
Atom type   X coordinate   Y coordinate   Z coordinate (After the second line) 

[18] Properties Estimation 

I. Groups for estimation in this program 
－CH3(non-ring) －CH2－(ring) －OH(phenol) >NH(non-ring) 
>CH2(non-ring) >CH－(ring) －O－(non-ring) >NH(ring) 
>CH－(non-ring) >C<(ring) －O－(ring) >N－(non-ring) 
>C<(non-ring) =CH－(ring) >C=O(non-ring) －N=(non-ring) 
=CH2(non-ring) =C<(ring) >C=O(ring) －N=(ring) 
=CH－(non-ring) －F O=CH－(aldehyde) －CN 
=C<(non-ring) －Cl －COOH(acid) －NH2 
=C=(non-ring) －Br －COO－(ester) －SH 

CH(non-ring) －I ＝O(except as above) －S－(non-ring) 
C－(non-ring) －OH(alcohol) －NH2 －S－(ring) 

II. Properties 
1) Joback 

Joback Method Boiling Point (K) / (℃) 
Joback Method Freezing Point (K) / (℃) 
Joback Method Critical Temperature Tc (K) / (℃) 
Joback Method Critical Pressure Pc (bar) / (atm) 
Joback Method Critical Volume Vc (cm3/mol)  
Edmister Method omega (From Joback Parameter Acentric Factor) 
Lee-Kesier Method omega (From Joback Parameter Acentric Factor) 
Critical Compressibility factor Zc  
Yen-Woods Method Density (g/cm3)  
Reidel Method Vapor Pressure (mmHg)  
Vetre Method Heat of Vaporization (at boiling point) (cal/mol) 
L-J Collision Diameter for Chemkin program(Å)  
L-J Well Depth for Chemkin program(J/mol) 
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2) Modified Joback 
Modified Joback Boiling Point (K) / (℃)  
Modified Joback Critical Temperature (K) / (℃) 
Modified Joback Critical Pressure (bar) / (atm) 
Modified Joback Critical Volume (cm3/mol)  
Edmister Method omega  
Lee-Kesler Method omega  
Critical Compressibility factor Zc 
Density Estimation (at 298K) (g/cm3)  
Yen-Woods Density Estimation (g/cm3)  
Riedel Vapor Pressure (at 298K) (mmHg)  
Vetre Method Heat of Vaporization. (at boiling point) (cal/mol)  
Heat Capacity Estimation (at 298K) (cal/mol K)  
Gibbs Energy (kcal/mol)  
Heat of Formation (kcal/mol)  
Thermal Conductivity (at 298K) (mW/mK) of Gas 
Thermal Conductivity (at 298K) (mW/mK) of Liquid 
Molecular Surface Estimation (Å2)  
Molecular Volume Estimation (Å3)  
Surface Tension Estimation (at 298K) (dyne) 

[19] References 
●CNDO/2 

Pople, J. A., Beveridge, D. L., “Approximate Molecular Orbital Theory”, McGraw-Hill, New York, 
1970. 
●Gaussian 

http://www.gaussian.com/ 
●GAMESS 

http://www.msg.ameslab.gov/GAMESS/GAMESS.html 
●MOPAC 

[1] Dewar, M.J.S., Thiel, W., J. Am. Chem. Soc., 1977, 99, 4899, 3907. 
[2] Dewar, M.J.S., Zoebisch, E.G., Healy, E.F., Stewart, J..P., J. Am. Chem. Soc., 1985, 107, 

3902.,  
[3] Dewar, M.J.S., Stroch, D.M., J. Am. Chem. Soc., 1985, 107, 3898. 
[4] Stewart, J.J.P., J. Comput. Chem., 1989, 10, 209, 221. 
●Q-Chem 

http://www.q-chem.com/ 
●Joback 

Joback, K. G., “S.M. thesis in chemical engineering”, Massachusetts Institute of Technology, 
Cambridge, Massachusetts, 1984. 

 
Please send the bug reports to following e-mail address. 
molworks@bestsystems.co.jp 
 

 37

http://www.gaussian.com/
http://www.msg.ameslab.gov/GAMESS/GAMESS.html
http://www.q-chem.com/

	[1] About MolWorks
	[2] System Requirements
	[3] How To Start Up
	[4] Display Contents
	I. Main Menu
	1) File
	1)-a. New
	1\)-b. Open…
	1)-b-1: File name
	1)-b-2: Files of type
	1)-b-3: In the case of reading Gaussian input file (h2o.com)
	1)-b-4: In the case of reading Gaussian output file (h2o.log)
	1)-b-5: In the case of reading GAMESS input file (h2o.inp)
	1)-b-6: In the case of reading GAMESS output file
	1)-b-7: In the case of reading MOPAC input file (benz.dat)
	1)-b-8: In the case of reading MOPAC output file (benz.out)
	1)-b-9: In the case of reading Q-Chem input file (water.in)
	1)-b-10: In the case of reading Q-Chem output file (water.ref)
	1)-b-11: The orbital energy level
	1)-b-12: Frequency

	1\)-c. Rename…
	1\)-d. Close…
	1\)-e. Save As…
	1)-f. Exit

	2) View
	2)-a. Molecule
	2)-b. Periodic Table
	2)-c. Messages

	3) MO
	3)-a. Interface
	3)-b. Calc

	4) Properties
	4)-a. Estimation

	5) Window
	5)-a. Already existed window(s)

	6) Help
	6)-a. System Information
	6)-b. About MolWorks


	II. Main Window
	III. Status Bar

	[5] Molecule Window
	I. Menu Bar
	1) Edit
	1)-a. Undo
	1)-b. Redo
	1)-c. Cut
	1)-d. Copy
	1)-e. Paste
	1)-f. Delete
	1)-g. Select
	1)-g-1: All
	1)-g-2: Atom
	1)-g-3: Box
	1)-g-4: Element Type
	1)-g-5: Bond

	1)-h. Atom Type
	1)-i. UnSelect
	1)-j. Draw
	1)-k. Add Hydrogens
	1)-l. Clean

	2) Measure
	2)-a. Distance
	2)-b. Angle
	2)-c. Dihedral

	3) Bond
	3\)-a. Single・Double・Triple

	4) Label
	4)-a. Element Symbols
	4)-b. Serial Numbers
	4)-c. Charge

	5) Display
	5)-a. Wire
	5)-b. Ball & Stick
	5)-c. MO
	5)-d. Wire Frame Movement
	5)-e. Axis
	5)-f. Home position
	5)-g. Center


	II. Tool Bar

	[6] Periodic Table Window
	[7] Simplified Setting Window
	I. Selecting the Q-Chem button.
	1)

	II. Selecting the Gaussian button
	1)

	III. Selecting the GAMESS button
	1)

	IV. Selecting the MOPAC button
	1)

	V. Q-Chem・Gaussian・GAMESS・MOPAC

	[8] MO Window
	I. Q-Chem
	1) Calc. Type
	2) Calc. Level
	3) Basis Set
	4) Polarization/Diffuse
	5) Geometry
	6) Charge
	7) Spin
	8)

	II. Gaussian
	1) Output Level
	2) Calc. Type
	3) Calc. Level
	4) Basis Set
	5) Polarization/Diffuse
	6) Geometry
	7) Charge
	8) Spin
	9)
	10) Input Data Conversion
	11) Run Gaussian Job

	III. GAMESS
	1) Calc. Type
	2) Optimize Cycle
	3) Optimize Precision
	4) Calc. Level
	5) Geometry
	6) Basis Set
	7) Polarization
	8) Diffuse
	9) Time Limit
	10) Memory
	11) Charge
	12) Spin
	13)

	IV. MOPAC
	1) Calc. Method
	2) Calc. Type
	3) Geometry
	4) Calc. Type Parameters
	4)-a. Optimize Algorithm
	4)-b. Thermo Data
	4)-b-1: Initial Temp.
	4)-b-2: Final Temp.
	4)-b-3: Step Number
	4)-b-4: Symmetric Number

	4)-c. Interatomic Distance Check
	4)-d. Orbital output
	4)-e. Time Limit
	4)-f. Charge
	4)-g. Spin
	4)-h.



	[9] Setup Window
	
	1) Work Directory
	2) Application
	3) Other setup
	3)-a. Linux
	3)-b. Windows



	[10] CNDO / 2 Window
	I. Input Parameters
	1) SCF convergency
	2) Max Cycles
	3) Charge
	4) Spin

	II. Results
	1) Number of Cycle
	2) Energy Difference (a.u.)
	3) Energy (a.u.)

	III. Dipole Results
	1) Dipole (debye)
	2) X (debye),Y (debye),Z (debye)

	IV.
	V.
	VI.

	[11] Display MO Window
	I. Current Energy Level
	II. Change Level
	III. S Scale
	IV. P Scale
	V. Show MO
	VI. MO Level

	[12] Estimation Window
	I. Pure Properties
	1) Molecule
	2) Parameter
	2)-a. Joback
	2)-b. Modified Joback

	3)
	4) Graph
	4)-a.


	II. PVT
	1) First Molecule
	1)-a. Molecule
	1)-b. Mol Ratio
	1)-c. Exp. Boiling P.

	2) Second Molecule
	3)


	[13] Functional Groups Window
	[14] Messages Window
	[15] How to use mouse
	I. Rotation
	II. Rotation (Z axis: perpendicular to the window)
	III. Magnification and Reduction

	[16] About dealing molecule(s)
	I. Max atoms
	II. Move atom(s)
	1) Moving all atoms
	2) Moving the selected atom

	III. Building the molecule

	[17] Supported file format
	I. Import
	II. Export
	III. XYZ type

	[18] Properties Estimation
	I. Groups for estimation in this program
	II. Properties
	1) Joback
	2) Modified Joback


	[19] References

